Most - but NOT all - of the shortcuts are language-independent. In particular, most of the Alt menu shortcuts are NOT;

but you can find out the Alt menu shortcut in your
language by looking at which letters are underlined on the relevant menus.

Where the 'Vrsn' column shows <9>.", the command is only supported in Word 2000 and above

Word Command Description Version Menu Shortcut

ActivateObject Activates an object
AllCaps Makes the selection all capitals (toggle) Ctrl + Shift + A
ApplyHeadingl Applies Heading 1 style to the selected text Alt+Ctrl +1
ApplyHeading?2 Applies Heading 2 style to the selected text Alt+ Ctrl +2
ApplyHeading3 Applies Heading 3 style to the selected text Alt+ Ctrl +3
ApplyListBullet Applies List Bullet style to the selected text Ctrl + Shift + L
AppMaximize Enlarges the application window to full size Alt + F10
AppMinimize Minimizes the application window to an icon
AppMove Changes the position of the application window
AppRestore Restores the application window to normal size Alt + F5
AppSize Changes the size of the application window
AutoFitContent Auto-Fit Table to the contents <9>
AutoFitFixed Set table size to a fixed width <9>
AutoFitWindow Auto-Fit Table to the window <9>
AutoMarkIndexEntries Inserts index entries using an automark file
AutomaticChange Performs the suggested AutoFormat action
AutoScroll Starts scrolling the active document
AutoSummarizeClose Turns AutoSummarize view off
AutoSummarizePercentOfOriginal Changes the size of the automatic summary
AutoSummarizeToggleView Switches how Word displays a summary: highlighting summary

text, or hiding everything but the summary.
AutoSummarizeUpdateFileProperties Updates File/Properties information with the current summary
AutoText Creates or inserts an AutoText entry depending on the selection
Bold Makes the selection bold (toggle) Formatting toolbar Ctrl+B
BoldRun Makes the current run in the selection bold (toggle) - whatever that <9>

means!
BorderAll Toggles all the borders of the selected table cells on or off
BorderBottom Changes the bottom border of the selected paragraphs, table cells,

and pictures




Word Command Description Version Shortcut
BorderHoriz Changes the horizontal borders of the selected table cells

BorderInside Changes the inside borders of the selected paragraphs, table cells,
and pictures

BorderLeft Changes the left border of the selected paragraphs, table cells, and
pictures

BorderLineColor Changes border line color of the selected paragraphs, table cells,
and pictures

BorderLineStyle Changes border line styles of the selected paragraphs, table cells,
and pictures

BorderLineWeight Changes border line weights of the selected paragraphs, table cells,
and pictures

BorderNone Removes borders from the selected paragraphs, table cells, and
pictures

BorderOutside Changes the outside borders of the selected paragraphs, table cells,
and pictures

BorderRight Changes the right border of the selected paragraphs, table cells, and
pictures

BorderTLtoBR Changes the top left to bottom right diagonal of the selected table <9>
cells

BorderTop Changes the top borders of the selected paragraphs, table cells, and
pictures

BorderTRtoBL Changes the top right to bottom left diagonal of the selected table <9>
cells

BorderVert Changes the vertical borders of the selected table cells

BottomAlign Aligns cell content to the bottom of cell - very useful and Word 97 right-click menus
unfortunately, not accessible via the default Word 2000. menus. It is and Word 97 Tables and
well worth replacing the Word 2000 Cell Alignment buttons on the Borders menu

right-click table menus and on the Tables and Borders toolbar, with
BottomAlign, CenterAlign and TopAlign buttons. The Word 2000
buttons, unfortunately, apply manual left center or justified
paragraph formatting to the text in the cells, which is the last thing
you would ever want to happen!




Word Command

Description

Version

Shortcut

BottomCenterAlign Aligns cell content to the bottom-center of cell (yuckk!!) <9> |Word 2000 right-click
menus and Word 2000
Tables and Borders menu
BottomLeftAlign Aligns cell content to the bottom-left of cell (yuckk!!) <9> |Word 2000 right-click
menus and Word 2000
Tables and Borders menu
BottomRightAlign Aligns cell content to the bottom-right of cell (yuckk!!) <9> |Word 2000 right-click
menus and Word 2000
Tables and Borders menu
BrowseNext Jump to the next browse object Double-down-arrow Ctrl + PgDn
below vertical scrollbar
BrowsePrev Jump to the previous browse object Double-up-arrow below |Ctrl + PgUp
vertical scrollbar
BrowseSel Select the next/prev browse object Alt + Ctrl + Home
Cancel Terminates an action Esc
CellOptions Changes the height and width of the rows and columns in a table <9>
CenterAlign Aligns cell content to the center of cell - very useful and Word 97 right-click menus
unfortunately, not accessible via the default Word 2000. menus. It is and Word 97 Tables and
well worth replacing the Word 2000 Cell Alignment buttons on the Borders menu
right-click table menus and on the Tables and Borders toolbar, with
BottomAlign, CenterAlign and TopAlign buttons. The Word 2000
buttons, unfortunately, apply manual left center or justified
paragraph formatting to the text in the cells, which is the last thing
you would ever want to happen!
CenterPara Centers the paragraph between the indents Formatting toolbar Ctrl+E
ChangeByte Changes between wide and narrow versions of the letters in the <9>
selection
ChangeCase Changes the case of the letters in the selection Shift+F3
ChangeKana Changes the characters in the selection between Katakana and <9>

Hiragana




Word Command

Version

Shortcut

Description

CharLeft Moves the insertion point to the left one character Left arrow

CharLeftExtend Extends the selection to the left one character Shift + Left arrow

CharRight Moves the insertion point to the right one character Rt arrow

CharRightExtend Extends the selection to the right one character Shift + Rt arrow

CharScale Applies scaling to the selection

CheckBoxFormField Inserts a check box form field Forms toolbar

ClosePane Closes the active window pane (if you are in Normal View and Close button on the Alt + Shift + C
have, for example, the Footnote pane open) relevant panes

ClosePreview Exits print preview

CloseUpPara Removes extra spacing above the selected paragraph

CloseViewHeaderFooter

Returns to document text

ColumnSelect Selects a columnar block of text Alt+Drag (or press Ctrl +
Shift + F8 and drag, but Alt
+ Drag is far easier)

CommaAccent Formats the selection with comma accents (toggle)

Connect Connects to a network drive

ContextHelp Turn on and off context sensitive help via the F1 key <9>

ControlRun Displays the Control Panel or the Clipboard

ConvertObject Converts or activates an object as another type

ConvertTextBoxToFrame Converts a single selected textbox into a frame Rt-click

CopyFormat Copies the formatting of the selection Ctrl +Shift+C

CopyText Makes a copy of the selection without using the clipboard (press Shift + F2

Return to paste)

CreateAutoText Adds an AutoText entry to the active template Alt + F3

CreateSubdocument Transforms the selected outline items into subdocuments

CreateTable Displays Table toolbar

CreateTask Creates a Microsoft Outlook task from the current selection

DecreaseIndent Decreases indent or promotes the selection one level Formatting toolbar

DefaultCharBorder Default Character Border <9>

DefaultCharShading Default Character Shading <9>

DeleteAnnotation Delete comment

DeleteBackWord Deletes the previous word without putting it on the Clipboard Ctrl+ Backspace




Word Command Description Version Shortcut

DeleteHyperlink Remove Hyperlink <9>
DeleteWord Deletes the next word without putting it on the Clipboard Ctrl + Del
DemoteList Demotes the selection one level (but this is NOT the OutlineDemote

command, and doesn’t work as well as OutlineDemote)
DemoteToBodyText Applies the Normal style and converts the selected headings to

body text (although you could simply apply the Normal style

instead, using Ctrl+Shift+N)
DiacriticColor Changes the color of the Diacritics (whatever that’s supposed to <9>

mean!)
DisplayDetails Displays the Details of the selected address (whatever that’s

supposed to mean! Something to do with Outlook)
DistributeColumn Evenly distributes selected columns or all columns if none selected Table menu
DistributePara Force-justifies paragraph <9>
DistributeRow Evenly distributes selected rows Table menu
DocClose Prompts to save the document and then closes the active window. Ctrl+W, Ctrl+F4

(But doesn’t intercept the menu command)
DocMaximize Enlarges the active window to full size Ctrl + F10
DocMinimize Minimizes the active window to an icon
DocMove Changes the position of the active window Ctrl + F7
DocRestore Restores the window to normal size Ctrl + F5
DocSize Changes the size of the active window Ctrl + F8
DocSplit Splits the active window horizontally and then adjusts the split Window menu Alt+Ctrl +S
DoFieldClick Executes the action associated with macrobutton fields Alt + Shift + F9
DotAccent Formats the selection with dot accents (toggle) <9> |Word 2000 Extended

Formatting toolbar
DottedUnderline Underlines the selection with dots (toggle)
DoubleStrikethrough Makes the selection double strikethrough (toggle)
DoubleUnderline Double underlines the selection (toggle) Word 2000 Extended Ctrl + Shift + D
Formatting toolbar

DrawAlign Aligns the selected drawing objects with one another or the page Draw menu
DrawBringForward Brings the selected drawing objects forward Draw menu




Word Command

DrawBringInFrontOfText

Description

Brings the selected drawing objects in front of text

Version

Shortcut

DrawBringToFront

Brings the selected drawing objects to the front

Draw menu

DrawCallout

Inserts a callout drawing object

DrawDisassemblePicture

Disassembles the selected metafile picture into drawing objects

DrawDuplicate Duplicates the selected drawing objects (without using the
clipboard)
DrawFlipHorizontal Flips the selected drawing objects from left to right
DrawFlipVertical Flips the selected drawing objects from top to bottom
DrawGroup Groups the selected drawing objects Draw menu AltR, G

DrawlInsertWordPicture

Opens a separate window for creating a picture object or inserts the
selected drawing objects into a picture

DrawNudgeDown Moves the selected drawing objects down Down arrow
DrawNudgeLeft Moves the selected drawing objects to the left Left arrow
DrawNudgeRight Moves the selected drawing objects to the right Right arrow
DrawNudgeUp Moves the selected drawing objects up Up arrow
DrawResetWordPicture Sets document margins to enclose all drawing objects on the page
DrawReshape Displays resizing handles on selected freeform drawing objects.

Drag a handle to reshape the object
DrawRotateLeft Rotates the selected drawing objects 90 degrees to the left
DrawRotateRight Rotates the selected drawing objects 90 degrees to the right
DrawSelectNext Selects the next drawing object
DrawSelectPrevious Selects the previous drawing object
DrawSendBackward Sends the selected drawing objects backward Draw menu
DrawSendBehindText Sends the selected drawing objects behind the text
DrawSendToBack Sends the selected drawing objects to the back Draw menu
DrawSnapToGrid Sets up a grid for aligning drawing objects Draw menu AltR, 1
DrawTextBox Inserts an empty textbox or encloses the selected item in a textbox Drawing toolbar
DrawUngroup Ungroups the selected group of drawing objects Draw menu AltR, U
DrawUnselect Deselects a drawing object
DrawVerticalTextBox Inserts an empty vertical text box or encloses the selected item in a <9>

vertical textbox

DropDownFormField

Inserts a drop-down form field

Forms toolbar




Word Command

Version

Shortcut

Description

EditAutoText Inserts or defines AutoText entries (but doesn’t intercept the menu
commend)
EditBookmark Brings up the bookmark dialog Insert menu Ctrl+Shift+F5 (Or: Alt I, K)
EditClear Performs a forward delete or removes the selection without putting Edit menu Del
it on the Clipboard
EditConvertAllEndnotes Converts all endnotes into footnotes
EditConvertAllFootnotes Converts all footnotes into endnotes
EditConvertNotes Converts selected footnotes into endnotes, or converts selected
endnotes into footnotes
EditCopy Copies the selection and puts it on the Clipboard Edit menu & Standard Ctrl+C
toolbar
EditCopyAsPicture Copies the selection and puts it on the Clipboard as a picture
EditCut Cuts the selection and puts it on the Clipboard Edit menu & Standard Ctrl+X
toolbar
EditFind Finds the specified text or the specified formatting Edit menu Ctrl+F
EditGoTo Jumps to a specified place in the active document Edit menu F5, Ctrl+G
EditHyperlink Edit Hyperlink (does not intercept the menu command)
EditIMEReconversion Reconvert using IME (whatever that means!) <9>
EditLinks Allows links to be viewed, updated, opened, or removed Edit menu AltE, K
EditObject Opens the selected object for editing
EditPaste Inserts the Clipboard contents at the insertion point Edit menu & Standard Ctrl+V
toolbar
EditPasteAsHyperlink Inserts the Clipboard contents as a hyperlink object
EditPasteAsNestedTable If a table has been copied, and if pasting into a table cell, pastes itas| <9>
a nested table (not supported in Word 97). Unfortunately, this is the
default paste behaviour anyway in Word 2000.
EditPasteSpecial Inserts the Clipboard contents as a linked object, embedded object, Edit menu AltE, S
or other format
EditRedo Redoes the last action that was undone Standard toolbar Alt + Shift + Backspc
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Description

Version

Shortcut

EditRedoOrRepeat Repeats the last command, or redoes the last action that was Edit menu F4
undone (unfortunately, doesn’t work for as many commands in
Word 2000 as in Word 97 and below, but this is still one of Word’s
most useful shortcuts, if not the most useful)
EditReplace Finds the specified text or the specified formatting and replaces it Edit menu Ctrl+H
EditSelectAll Selects the entire document Edit menu Ctrl+A
EditSwapAllNotes Changes all footnotes to endnotes and all endnotes to footnotes
EditTOACategory Modifies the category names for the table of authorities
EditUndo Reverses the last action Edit menu & Standard Ctrl+Z
toolbar
EditUpdateIMEDic Update IME dictionary (whatever that means!) <9>
EditWrapBoundary Edit the wrapping boundary for a picture or drawing object
EmailCheckNames Verifies the recipient names in the e-mail envelope <9>
EmailEnvelope Displays or hides the e-mail “envelope” <9>
EmailFlag Displays the envelope’s message flag dialog <9>
EmailFocusSubject Switches focus to the e-mail envelope’s subject field <9>
EmailMessageOptions Displays the e-mail envelope’s options dialog <9>
EmailOptions Changes various categories of Word’s E-Mail options <9>
EmailSaveAttachment Saves the attachments of a e-mail envelope message <9>
EmailSelectBccNames Displays the e-mail address book to add recipients to the Bec field <9>
EmailSelectCcNames Displays the e-mail address book to add recipients to the Cc field <9>
EmailSelectNames Displays the e-mail address book <9>
EmailSelectToNames Displays the e-mail address book to add recipients to the To field <9>
EmailSend Executes the e-mail envelope’s Send command <9>
EmailSignatureOptions Create or changes AutoSignature entries <9>
EndOfColumn Moves to the last cell in the current table column Alt + PageDn (to select to

end of column, use Alt +
Shift + PgDn)
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Version

Shortcut

Description

EndOfDocExtend Extends the selection to the end of the last line of the document Ctrl+Shift+End
EndOfDocument Moves the insertion point to the end of the last line of the document Ctrl+End
EndOfLine Moves the insertion point to the end of the current line End
EndOfLineExtend Extends the selection to the end of the current line Shift+End
EndOfRow Moves to the last cell in the current row Alt+End
EndOfWindow Moves the insertion point to the end of the last visible line on the Alt + Ctr] + PgDn

screen
EndOfWindowExtend Extends the selection to the end of the last visible line on the screen Shift + Alt + Ctrl + PgDn
ExtendSelection Turns on extend selection mode and then expands the selection Status bar (double-click) |F8 (press Esc to turn off)

with the direction keys
FileClose Closes all of the windows of the active document (this command File menu

does intercept the menu command, unless the Shift key is held

down; and the x close button. But it does not intercept any of the

keyboard shortcuts, which are assigned to DocClose for reasons that

will forever remain a mystery. Using an AutoClose macro is a better

way of intercept documents closing).
FileCloseAll Closes all of the windows of all documents File menu with Shift key

held down

FileCloseOrExit Closes the current document, or if no documents are open, quits <9> Alt + F4 (<9>)

Word. Horrible command, as it makes it a long winded business to

quit Word. But there’s a simple solution - assign Alt+F4 to FileExit

instead.
FileCloseOrCloseAll Performs FileClose or, if the shift key is down, FileCloseAll (this File menu

command does intercept the menu command and the x close button

but does not intercept any of the keyboard shortcuts. Using an

AutoClose macro is a better way of intercept documents closing).
FileConfirmConversions Toggles asking the user to confirm the conversion when opening a

file.
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Version

Shortcut

Description

FileExit Quits Microsoft Word and prompts to save the documents (does File menu Alt + F4 (Word 97)
intercept the menu item, but not the keyboard shortcut, or the x
button. An AutoExit macro is usually a better way of intercepting
this).
FileFind Locates the documents in any directory, drive, or folder
FileNew Creates a new document or template (brings up the dialog). Note File menu (but not std NOT Ctrl+N!!
that: Word pretends that Ctrl+N is assigned to FileNew but it isn’t, toolbar)
it’s assigned to FileNewDefault You can fix this in Word 2000 by
assigning Ctrl+N to the FileNewDialog command. In Word 97 the
only way to fix it is to create a macro called FileNew (to do this,
press Alt + F8, type "FileNew" without the quotes and Click
"Create". The macro will automatically contain the code needed to
make it work).
FileNewDefault Creates a new document based on the Normal template. Std toolbar Ctrl+N
FileNewDialog Creates a new document or template (brings up the dialog) - <9>
although Word claims otherwise (well they probably had too much
to drink when they documented it).
FileNewEmail Creates a new email message <9>
FileNewPrint Same as FileNewDefault (another drunken binge?) <9>
FileNewWeb Creates a new document based on the Normal template which, <9>
when you save it, will default to saving it as a web page.
FileOpen Opens an existing document or template File menu & std toolbar  |Ctrl+O
FilePageSetup Changes the page setup of the selected sections File menu AltF, U
FilePost Puts the active document into an Exchange folder
FilePrint Prints the active document (brings up the dialog) File menu Ctrl + P
FilePrintDefault Prints the active document using the current defaults Std toolbar
FilePrintPreview Displays full pages as they will be printed File menu & std toolbar | Ctrl+F2
FilePrintPreviewFullScreen According to Word it toggles full screen, but it doesn’t actually do
anything at all - this is not the View + Full screen command.
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Description

Version

Shortcut

FilePrintSetup Changes the printer and the printing options without bringing up
the Print menu
FileProperties Shows the properties of the active document File menu AltF 1
FileRoutingSlip Adds or changes the electronic mail routing slip of the active File + Send to menu
document
FileSave FileSave File menu, std toolbar Ctrl+S
FileSaveAll Saves all open files, their attached templates, and any addins that File menu & std toolbar
are loaded, if they have been amended since the last save; with Shift key down
prompting for each one separately
FileSaveAs Saves a copy of the document in a separate file (brings up the File menu AltF, A (or F12)
dialog)
FileSaveAsWebPage Saves a copy of the document in a separate HTML file <9> |File menu
FileSaveFrameAs Saves a copy of the current web frame document in a separate file <9>
Don’t confuse web frames with Word frames - Word frames (which
you can insert using the Forms toolbar) are a bit like textboxes and
are very useful, but this command relates to web frames.
FileSaveHtml Does the same thing as the FileSaveAsWebPage command. In Word Word 97 File menu
97, it intercepts the menu command; in Word 2000, it doesn’t (great
compatibility decision!)
FileSaveVersion Saves a new version of a document (use at your peril!). Not the
menu command (which is FileVersions)
FileSendMail Sends the active document through electronic mail File menu
FileSummaryInfo Shows the summary information about the active document (was a
predecessor to FileProperties, kept for backward compatibility)
FileTemplates Changes the active template and the template options Tools menu
FileVersions Manages the versions of a document (use at your perill) File menu
FixMe Runs Detect and Repair <9> |Help menu
(Office 9 and above)
Font Activates the Fonts listbox on the formatting toolbar Formatting toolbar Ctrl+Shift+F
FontColor Changes the colour of the selected text to the current default colour
as defined in the Font Colour button on the Formatting toolbar.
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Version

Shortcut

Description

FontSizeSelect Activates the Font Size drop-down on the formatting toolbar Formatting toolbar Ctrl+Shift+P
FontSubstitution Changes the document’s font mapping
FormatAddrFonts Formats the delivery address font for envelopes
FormatAutoFormat Automatically formats a document (or sometimes, automatically Format menu Alt+ Ctrl + K
screws it up)
FormatAutoFormatBegin Automatically formats a document
FormatBackgroundFillEffect Provides fill effects for the background color (only useful for Format menu
creating web pages, as background colours do not print)
FormatBackgroundMoreColors Provides more color choices for the background color
FormatBordersAndShading Changes the borders and shading of the selected paragraphs, table Format menu AltO, B
cells, and pictures
FormatBulletDefault Creates a bulleted list based on the current defaults. Use at your Formatting toolbar
peril - it’s far better to apply styles.
FormatBulletsAndNumbering Creates a numbered or bulleted list (brings up the dialog). Use at Format menu
your peril - it’s far better to apply styles.
FormatCallout Formats the selected callouts or sets callout defaults
FormatChangeCase Changes the case of the letters in the selection Format menu AltO,E
FormatChangeCaseFareast Changes the case of the letters in the selection, in certain language Format menu
versions of Word
FormatColumns Changes the column format of the selected sections (brings up the Format menu AltO, C
dialog)
FormatCombineCharacters “Combines Characters” (doesn’t seem to do anything useful <9> |Word 2000 Extended
though) Formatting toolbar
FormatDrawingObject Changes the properties of the selected drawing objects
FormatDropCap Formats the first character of current paragraph as a dropped Format menu AltO,D
capital (must select it first)
FormatEncloseCharacters Enclose characters in a circle (but doesn’t work properly) <9> |Word 2000 Extended
Formatting toolbar
FormatFitText Doesn’t appear to do anything <9>
FormatFont Brings up the Format + Font dialog Format menu Ctrl+D
FormatFrame Changes the options for Word frame formatting (meaning “frames” Rt-click on a frame
as in the things that are a bit like textboxes but work better - not
web frames.
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FormatHeaderFooterLink Links the current header/footer to the previous section (but does Alt + Shift + R
not intercept the button on the Header Footer toolbar)
FormatHeadingNumbering Brings up the Outline tab of the Format Bullets and Numbering
dialog (use at your peril - it’s far better to define styles)
FormatHorizontallnVertical Doesn’t appear to do anything <9>
FormatLineColor Applies the current default line colour (as set in the line colour
button on the Drawing toolbar) to any selected drawing objects
FormatMultilevelDefault Creates a numbered list based on the current defaults (use at your
peril - much better to apply styles)
FormatNumberDefault Creates a numbered list based on the current defaults (use at your Formatting toolbar
peril - much better to apply styles)
FormatPageNumber Brings up the Page Number Format dialog and applies the settings HeaderFooter toolbar
without inserting a new page number in a frame (so is much more
useful than the menu item)
FormatParagraph Brings up the Format Paragraph dialog Format menu AltO, P
FormatPhoneticGuide Inserts a Phonetic Guide field in the active document <9> |Word 2000 Extended
Formatting toolbar
FormatPicture Changes the picture scaling, size, and cropping information (but
does not intercept the menu command)
FormatRetAddrFonts Formats the return address font for envelopes
FormatSectionLayout Changes the page format of the selected sections
FormatSimpleNumberDefault Creates a numbered list based on the current defaults (use at your
peril - applying styles is much better)
FormatStyle Applies, creates, or modifies styles Format menu AltO,S
FormatStyleGallery Apply styles from other templates to the current document (note
doing this is the very bad practice, bring contrary to the entire
philosophy of using templates).
FormatTabs Brings up the Format Tabs dialog Format menu AltO, T
FormatTextFlow Changes text flow direction and character orientation in a table cell Rt-click menu
FormatTheme Brings up the dialog to apply a web theme (only useful for web <9> |Format menu
pages)
FormFieldOptions Brings up the dialog to change the options for a form field Forms toolbar
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FormShading Changes shading options for the current form Forms toolbar
FrameProperties Changes the Properties of a Web Frame <9> | (Web) Frames toolbar
FrameRemoveSplit Removes the current Web frame <9> [(Web) Frames toolbar
FramesetTOC Create a Web frameset table of content <9> (Web) Frames toolbar
FramesetWizard Turns the current window into a Web frameset <9> |Format menu
FrameSplitAbove <9> (Web) Frames toolbar
FrameSplitBelow Splits the active Web frame, adding the new Web frame below the <9> | (Web) Frames toolbar
current one
FrameSplitLeft Splits the active Web frame, adding the new Web frame to the left off <9> | (Web) Frames toolbar
the current one
FrameSplitRight Splits the active Web frame, adding the new Web frame to the right <9> | (Web) Frames toolbar
of the current one
GoBack Returns to the previous insertion point (goes back to up to 3 points, Shift + F5
then returns to where you started; this is one of the most useful
shortcuts of them all. Also useful when opening a document, if you
want to g straight to where you were last editing it)
GotoCommentScope Doesn’t seem to do anything
GoToHeaderFooter Jumps between Header and Footer HeaderFooter toolbar
GoToNextComment Jumps to the next comment in the active document (but you can
also do this using Edit + Goto)
GoToNextEndnote Jumps to the next endnote in the active document (but you can also
do this using Edit + Goto)
GoToNextFootnote Jumps to the next footnote in the active document (but you can also
do this using Edit + Goto)
GotoNextLinked TextBox Selects the next linked text box Text box toolbar & rt-click
menu
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Description

Shortcut

GoToNextPage

Jumps to the top of the next page in the active document (you can
also do this using Edit + Goto, and if you're lucky, with the Browse
Next button at the bottom of the vertical scrollbar; or you can assign
it to a shortcut of your own. Alternatively, if you want to be able to
go down one full page, so you go to the same relative position on
the next page as on the current one, assign the NextPage command
to a shortcut instead).

GoToNextSection

Jumps to the next section in the active document (but you can also
do this using Edit + Goto)

GoToPreviousComment

Jumps to the previous comment in the active document (but you
can also do this using Edit + Goto)

GoToPreviousEndnote

Jumps to the previous endnote in the active document (but you can
also do this using Edit + Goto)

GoToPreviousFootnote

Jumps to the previous footnote in the active document (but you can
also do this using Edit + Goto)

GoToPreviousPage

Jumps to the top of the previous page in the active document (you
can also do this using Edit + Goto, and if you're lucky, with the
Browse Previous button at the bottom of the vertical scrollbar; or
you can assign it to a shortcut of your own. Alternatively, if you
want to be able to go up one full page, so you go to the same
relative position on the previous page as on the current one, assign
the PrevPage command to a shortcut instead).

GoToPreviousSection

Jumps to the previous section in the active document (but you can
also do this using Edit + Goto)

GotoPrevLinkedTextBox

Selects the previous linked text box

Text box toolbar & rt-click
menu

GrowFont Increases the font size of the selection Ctrl + >
GrowFontOnePoint Increases the font size of the selection by one point Ctrl +]

HangingIndent Increases the hanging indent Ctrl + T (or drag the ruler)
Help Microsoft Word Help Help menu F1

HelpAbout Displays the program information, Word version number and the Help menu

copyright




Word Command

Shortcut

Description

HelpAW Locates Help topics based on an entered question or request
HelpContentsArabic Displays Arabic Help contents
HelpPSSHelp Displays information about the support available for Microsoft
Word
HelpTipOfTheDay Displays a Word Tip of the Day
HelpTool Lets you get help on a command or screen region or examine text Shift + F1
properties
HelpUsingHelp Displays the instructions for how to use Help
HelpWordPerfectHelp Shows the equivalent for a WordPerfect command
HelpWordPerfectHelpOptions Customizes WordPerfect Help
Hidden Makes the selection hidden text (toggle) Ctrl + Shift + H
Highlight Applies color highlighting to the selection
HyperlinkOpen Connect to a hyperlink’s address Click on it
IncreaseIndent Increases indent or demotes the selection one level
Indent Moves the left indent to the next tab stop Ctrl + M (or drag the ruler)
InsertAddCaption Adds a new caption type
InsertAddress Inserts an address from your Personal Address Book
InsertAnnotation Inserts a comment Insert menu Alt + Ctrl + M (or Alt I, M)
InsertAutoCaption Defines which objects are inserted with a caption (you can also get
to this dialog by selecting Insert + Caption + AutoCaption, but the
command won't intercept doing that)
InsertAutoText Replaces the name of the AutoText entry with its contents F3
InsertBreak Ends a page, column, or section at the insertion point Insert menu Alt1, B
InsertCaption Inserts a caption above or below a selected object Insert menu Alt], C
InsertCaptionNumbering Sets the number for a caption type (you can also get to this dialog
by clicking on the Numbering button after selecting Insert +
Caption)
InsertChart Inserts a Microsoft Graph object
InsertClipArt Word 97 and below only. Inserts a Microsoft Clip Art Gallery object. Word 97 Insert menu
The Word 2000 menu item does not seem to be interceptable!
InsertColumnBreak Inserts a column break at the insertion point Ctrl + Shift + Return
InsertCrossReference Inserts a cross-reference Insert menu
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Description
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Shortcut

InsertDatabase Inserts information from an external data source into the active Database toolbar
document
InsertDateField Inserts a date field Alt + Shift + D
InsertDateTime Inserts the current date and/or time into the active document Insert menu
InsertDrawing Inserts picture object (not a Drawing object as it claims to)
InsertEmSpace Inserts an EM space
InsertEndnoteNow Inserts an endnote reference at the insertion point without Alt+ Ctrl + D
displaying the dialog
InsertEnSpace Inserts an EN space
InsertEquation Inserts a Microsoft Equation object
InsertExcelTable Inserts a Microsoft Excel worksheet object (but does not intercept
the command on the Standard toolbar)
InsertField Inserts a field in the active document Insert menu AltLF
InsertFieldChars Inserts an empty field with the enclosing field characters Ctrl+F9
InsertFile Inserts the text of another file into the active document Insert menu AltL L
InsertFootnote Inserts a footnote or endnote reference at the insertion point Insert menu AltT, N
InsertFootnoteNow Inserts a footnote reference at the insertion point without displaying Alt + Ctrl + F
the dialog
InsertFormField Inserts a new form field
InsertFrame Inserts an empty frame or encloses the selected item in a frame (well Forms toolbar
worth adding to the Insert menu)
InsertHyperlink Insert Hyperlink Insert menu Ctrl + K
InsertIndex Collects the index entries into an index
InsertindexAndTables Inserts an index or a table of contents, figures, or authorities into the Insert menu AltI, D
document
InsertListNumField Inserts a ListNum Field Alt+ Ctrl + L
InsertMergeField Brings up a dialog to insert a mail merge field at the insertion point. Alt + Shift + F
(It does not intercept the button on the Mail merge. toolbar)
InsertNumber Pretty pointless command, just inserts a number as a formula field <9>
InsertNumberOfPages Inserts a number of pages field HeaderFooter toolbar
InsertObject Inserts an equation, chart, drawing, or some other object Insert menu




Word Command

Description

Shortcut

InsertOCX Inserts the selected OCX control or Registers a new OCX control
InsertOCXButton Inserts a Button Control Control toolbox toolbar
InsertOCXCheckbox Inserts a Checkbox Control Ditto
InsertOCXDropdownCombo Inserts a Combobox Control Ditto
InsertOCXFrame Inserts a Frame Control
InsertOCXImage Inserts an Image Control Ditto
InsertOCXLabel Inserts a Label Control Ditto
InsertOCXListBox Inserts a Listbox Control Ditto
InsertOCXOptionButton Inserts a RadioButton Control Ditto
InsertOCXScrollbar Inserts a Scrollbar Control Ditto
InsertOCXSpin Inserts a Spin Control Ditto
InsertOCXTextBox Inserts a Text Box Control Ditto
InsertOCXToggleButton Inserts a Toggle Button Control Ditto
InsertOfficeDrawing Inserts a Microsoft Draw 8.0 object (only it doesn’t!)
InsertPageBreak Inserts a page break at the insertion point Ctrl + Return
InsertPageField Inserts a page number field HeaderFooter toolbar Alt + Shift + P
InsertPageNumbers Adds page numbers to the top or the bottom of the pages - but it is
usually much better to use the buttons on the Header/footer toolbar
InsertPhotoEditorScan Inserts a Microsoft Photo Editor object
InsertPicture Inserts a picture from a graphics file Insert menu
InsertPictureBullet Inserts a picture as a bullet
InsertSectionBreak Ends a section at the insertion point
InsertSound Inserts a sound object into the document
InsertSpike Empties the spike AutoText entry and inserts all of its contents into Ctrl + Shift + F3
the document
InsertSubdocument Opens a file and inserts it as a subdocument in a master document Outlining toolbar
(but don’t use Master documents!)
InsertSymbol Inserts a special character Insert menu

InsertTableOf Authorities

Collects the table of authorities entries into a table of authorities

InsertTableOfContents

Collects the headings or the table of contents entries into a table of
contents

InsertTableOfFigures

Collects captions into a table of figures




Word Command

Description

Version

Shortcut

InsertTimeField Inserts a time field Alt + Shift + T
InsertVerticalFrame Does the same as InsertFrame except that the text in the frame is <9>

vertical
Italic Makes the selection italic (toggle) Formatting toolbar Ctrl +1
JustifyPara Aligns the paragraph at both the left and the right indent Formatting toolbar Ctrl +]
LeftPara Aligns the paragraph at the left indent Formatting toolbar Ctrl + L
LetterProperties Runs the Microsoft Letter wizard
LetterWizard Runs the Microsoft Letter wizard
LineDown Moves the insertion point down one line Down arrow
LineDownExtend Extends the selection down one line Shift + down arrow
LineUp Moves the insertion point up one line Up arrow
LineUpExtend Extends the selection up one line Shift + up arrow
ListCommands Create a table of Word commands, with key and menu assignments

(although unfortunately, the commands aren’t listed with their

correct names; and the descriptions aren’t listed; hence this article)
ListIndent Demotes the selection one level (but OutlinePromote works much

better)
ListOutdent Promotes the selection one level (but OutlineDemote works much

better)
LockDocument Toggles the file lock state of a Master Document (but avoid using Outlining toolbar

Master Documents)
LockFields Locks the selected fields to prevent updating Ctrl + F11
LTRMacroDialogs Makes macro dialogs display left-to-right, if they currently display <9>

right-to-left
LtrPara For all selected paragraphs, this method sets the reading order to <9>

left-to-right. If a paragraph with a right-to-left reading order is also

right-aligned, this method reverses its reading order and sets its

paragraph alignment to left-aligned.
LtrRun As above but for all contiguous characters sharing the same <9>

ReadingOrder attributes.
Magnifier Toggles between Edit mode and Zoom-in zoom-out mode Print Preview toolbar
MailCheckNames Checks the recipient names of a mail message




Word Command
MailHideMessageHeader

Description

Shows/hides the mail message header for Word as Email editor

Version

Shortcut

MailMerge

Merges a mail merge document with its datafile to the printer, a
new document, fax or email

Mail merge toolbar

MailMergeAskToConvertChevrons

Toggles asking the user about converting Word for the Macintosh
mail merge chevrons

MailMergeCheck Checks for errors in a mail merge Alt + Shift + K
MailMergeConvertChevrons Toggles converting Word for the Macintosh mail merge chevrons

MailMergeCreateDataSource Creates a new mail merge data source Mail merge toolbar
MailMergeCreateHeaderSource Creates a new mail merge header source

MailMergeDataForm Edits a list or table in a form Database toolbar
MailMergeEditDataSource Lets you edit a mail merge data source Mail merge toolbar Alt+Shift+E

MailMergeEditHeaderSource

Opens a mail merge header source

MailMergeEditMainDocument

Switches to a mail merge main document

Database toolbar

MailMergeFindRecord Finds a specified record in a mail merge data source Mail merge toolbar
MailMergeFirstRecord Displays the first record in the active mail merge data source (if The Mail merge toolbar
View Merged Data button is on)
MailMergeGoToRecord Displays the specified record in the active mail merge data source (if] Mail merge toolbar
The View Merged Data button is on)
MailMergeHelper Prepares a main document for a mail merge Tools menu & Mail merge
toolbar
MailMergelnsertAsk Inserts a Word Ask field at the insertion point
MailMergelnsertFillln Inserts a Word FILLIN field at the insertion point
MailMergelnsertIf Inserts a Word field at the insertion point

MailMergelnsertMergeRec

Inserts a Word record field at the insertion point

MailMergelnsertMergeSeq

Inserts a Word sequence field at the insertion point

MailMergelnsertNext Inserts a Word next field at the insertion point

MailMergelnsertNextIf Inserts a Word next if field at the insertion point

MailMergelnsertSet Inserts a Word set field at the insertion point

MailMergelnsertSkiplf Inserts a Word skip if field at the insertion point

MailMergeLastRecord Displays the last record in the active mail merge data source (if The Mail merge toolbar
View Merged Data button is on)

MailMergeNextRecord Displays the next record in the active mail merge data source (if The

View Merged Data button is on)




Word Command
MailMergeOpenDataSource

Description

Opens a data source for mail merge or insert database

Shortcut

MailMergeOpenHeaderSource

Opens a header source for mail merge

MailMergePrevRecord Displays the previous record in the active mail merge data source (if
The View Merged Data button is on)
MailMergeQueryOptions Sets the query options for a mail merge (very useful; worth adding
to the mail merge toolbar)
MailMergeReset Resets a mail merge main document to a normal document
MailMergeToDoc Collects the results of the mail merge in a document Mail merge toolbar Alt + Shift + N
MailMergeToPrinter Sends the results of the mail merge to the printer Mail merge toolbar Alt Shift+ M
MailMergeUseAddressBook Opens an address book as a data source for mail merge
MailMergeViewData Toggles between viewing merge fields and actual data Mail merge toolbar
MailMessageDelete Deletes a mail message
MailMessageForward Forwards a mail message
MailMessageMove Moves a mail message
MailMessageNext Goes to the next mail message
MailMessagePrevious Goes to the previous mail message

MailMessageProperties

Sets the properties of the mail message

MailMessageReply Replies to a mail message
MailMessageReplyAll Replies All to a mail message
MailSelectNames Selects the recipients of a mail message
MarkCitation Marks the text you want to include in the table of authorities Alt + Shift + 1
MarkIndexEntry Marks the text you want to include in the index Alt + Shift + X
MarkTableOfContentsEntry Inserts a TC field (but it is far better to use Heading Styles to Alt + Shift + O
generate your Table of Contents instead)
MenuMode Makes the menu bar active Alt or F10
MergeSubdocument Merges two adjacent subdocuments into one subdocument (but Outlining toolbar
avoid using Master Documents)
MicrosoftAccess Starts or switches to Microsoft Access Microsoft toolbar
MicrosoftExcel Starts or switches to Microsoft Excel Microsoft toolbar
MicrosoftFoxPro Starts or switches to Microsoft FoxPro Microsoft toolbar
MicrosoftMail Starts or switches to Microsoft Mail Microsoft toolbar
MicrosoftOnTheWeb1 through Takes you to various locations on the MS site. Word 97 Help menu
MicrosoftOnTheWeb17

MicrosoftPowerPoint

Starts or switches to Microsoft PowerPoint

Microsoft toolbar




Word Command

Description

Version

Shortcut

MicrosoftProject Starts or switches to Microsoft Project Microsoft toolbar
MicrosoftPublisher Starts or switches to Microsoft Publisher Microsoft toolbar
MicrosoftSchedule Starts or switches to Microsoft Schedule+ Microsoft toolbar
MicrosoftScriptEditor Starts or switches to Microsoft Development Environment <9> Alt + Shift + F11
application, allowing you to view the HTML/XML source code that
would be behind the document if it were in .htm format (or that is
behind it if it already is in .htm format).
MicrosoftSystemInfo Execute the Microsoft System Info application Alt + Ctrl + F1
MoveText Moves the selection to a specified location without using the F2
clipboard (press Return to execute the more)
NewToolbar Creates a new toolbar
NextCell Moves to the next table cell Tab
NextField Moves to the next field F11
NextInsert Returns to the next insertion point
NextMisspelling Find next spelling error Alt + F7
NextObject Moves to the next object on the page Alt + down arrow
NextPage Moves to the next page, but unlike the GotoNextPage command, it
moves down one full page.
NextWindow Switches to the next document window, equivalent to selecting a Ctrl + F6
document from the Window menu.
NormalFontPosition Removes the raised or lowered font attribute
NormalFontSpacing Removes the expanded or condensed font attribute
NormalStyle Applies the Normal style Ctrl+Shift+N
NormalViewHeaderArea Switches between the current primary Header and the main
document; if in Normal view, displays the Header in a Header
pane, so you can remain in Normal View. This would be useful if it
weren't for the fact that there is no way (without using a macro) of
going to any Header pane other than the primary one (so no way of
getting to the First Page Header pane, for instance).
NoteOptions Changes the options for footnotes or endnotes
OfficeOnTheWeb Word 2000 Help menu - takes you to Microsoft’s Office Update <9> |Help
page.
OK Confirms a location for copying or moving the selection

OnlineMeeting

Starts or switches to the Microsoft Netmeeting application




Word Command

Description

Shortcut

OpenOrCloseUpPara Sets or removes extra spacing above the selected paragraph Ctrl +0
OpenSubdocument Opens a subdocument in a new window. (But avoid using Master Double-clicking the little
Documents) icon to the left of the first
heading in a
subdocument, when in
Master Document view
OpenUpPara Sets extra spacing above the selected paragraph
Organizer Manages AutoText entries, styles, macros, and toolbars (allows you
to copy them between templates and documents)
OtherPane Switches to another window pane in Normal View (for instance, if F6
you have if you have a Footnotes pane open in Normal view and
want to switch to the main document and back without closing the
pane).
OutlineCollapse Collapses an Outline in Outline View by one level Outlining toolbar Alt+ _
OutlineDemote Demotes the selected paragraphs one heading level Outlining toolbar Alt+Shift+rt arrow
OutlineExpand Expands an Outline in Outline View by one level Outlining toolbar Alt + +
OutlineMoveDown Moves the selection below the next item in the outline Outlining toolbar Alt+Shift+down arrow
OutlineMoveUp Moves the selection above the previous item in the outline Outlining toolbar Alt+Shift+up arrow
OutlinePromote Promotes the selected paragraphs one heading level Outlining toolbar Alt+Shift+left arrow
OutlineShowFirstLine Toggles between showing the first line of each paragraph only or Outlining toolbar Alt + Shift + L
showing all of the body text in the outline
OutlineShowFormat Toggles the display of character formatting in outline view Outlining toolbar
Overtype Toggles the typing mode between replacing and inserting Ins
PageDown Moves the insertion point and document display to the next screen PgDn
of text
PageDownExtend Extends the selection and changes the document display to the next Shift+ PgDn
screen of text
PageUp Moves the insertion point and document display to the previous PgUp
screen of text
PageUpExtend Extends the selection and changes the document display to the Shift + PgUp
previous screen of text
ParaDown Moves the insertion point to the beginning of the next paragraph Ctrl + down arrow




Word Command

Shortcut

ParaDownExtend

Description
Extends the selection to the beginning of the next paragraph

Shift + Ctrl + down arrow

ParaKeepLinesTogether

Prevents a paragraph from splitting across page boundaries

better).

ParaKeepWithNext Keeps a paragraph and the following paragraph on the same page
ParaPageBreakBefore Makes the current paragraph start on a new page (also a setting

under Format + Paragraph)
ParaUp Moves the insertion point to the beginning of the previous Ctrl + up arrow

paragraph
ParaUpExtend Extends the selection to the beginning of the previous paragraph Shift + Ctrl + up arrow
ParaWidowOrphanControl Prevents a page break from leaving a single line of a paragraph on

one page (also a setting under Format + Paragraph)
PasteFormat Applies the previously copied formatting to selection Ctrl+Shift+V
PauseRecorder Pauses the macro recorder (toggle)
PresentIt Create a Microsoft PowerPoint presentation from the current

documents, using the Heading styles - Heading 1 paragraphs

become slide titles, 2s become main bullets, 3s become sub-bullets,

etc. (Equivalent to saving the Word document in RTF format and

then selecting Insert + Slides from Outline in PowerPoint). Quite

useful, and well worth putting on the Tools menu if you create a lot

of presentations).
PrevCell Moves to the previous table cell Shift + Tab
PrevField Moves to the previous field Shift + F11
PrevObject Moves to the previous object on the page Alt + up arrow
PrevPage Moves to the previous page, but unlike the GoToPreviousPage

command, it moves up one full page.
PrevWindow Switches back to the previous document window Ctrl + Shift + F6
PromoteList Promotes the selection one level (but OutlinePromote works much




Word Command Description Version Shortcut
RedefineStyle Redefines the current style based on the selected text (Equivalent to
clicking in the Styles box and pressing Return, although this
command does not intercept that action).

RemoveAllScripts Removes all HTML Scripts (embedded JavaScript etc) from the
current document.

RemoveBulletsNumbers Removes list numbers and list bullets from the selection (does not
remove manually typed numbers or bullets)

RemoveCellPartition Displays the “Eraser” tool so that you can merge table cells by Tables and Borders toolbar
“rubbing out” the cell partitions (it’s much simpler to select Table +
Merge cells though!)

RemoveFrames Removes frame formatting from the selection (we’re talking about

Word frames rather than web frames now - i.e. the things that are
similar to text boxes but work better).

RemoveSubdocument Merges the contents of the selected subdocuments into the master Outlining toolbar
document that contains them (but don’t use this command, as it
often corrupts the document)

RepeatFind Repeats Go To or Find to find the next occurrence Sfift+F4
ResetChar Makes the selection the default character format of the applied style Ctrl+Spacebar
ResetNoteSepOrNotice Resets a separator, continuation separator, or continuation notice to

the Word default
ResetPara Makes the selection the default paragraph format of the applied Ctrl+Q

style
RightPara Aligns the paragraph at the right indent Formatting toolbar Ctrl +R
RTLMacroDialogs Makes macro dialogs display right-to-left, if they currently display <9>

left-to-right

RtlPara For all selected paragraphs, this method sets the reading order to <9>
right-to-left. If a paragraph with a left-to-right reading order is also
left-aligned, this method reverses its reading order and sets its
paragraph alignment to right-aligned.

RtIRun As above but for all contiguous characters sharing the same <9>
ReadingOrder attributes.

RunPrintManager Displays Print Manager (except it doesn’t)




Word Command

Description

Version

Shortcut

RunToggle Toggles the insertion point between right-to-left and left-to-right <9>
runs
SaveTemplate Saves the document template of the active document (but it’s easier
to hold the Shift key down and select File + Save All)
ScheduleMeeting Launches the Microsoft Netmeeting application, ready to schedulea| <9>
meeting
ScreenRefresh Refreshes the display
SelectCurAlignment Selects downwards all continuous paragraphs with the same
alignment as the current one
SelectCurColor Selects downwards all continuous characters with the same font
colour as the current one
SelectCurFont Selects downwards all continuous characters with the same font
name and size as the current one
SelectCurlndent Selects downwards all continuous paragraphs with the same
indentation as the current one
SelectCurSpacing Selects downwards all continuous paragraphs with the same line
spacing as the current one
SelectCurTabs Selects downwards all continuous paragraphs with the same
tabstops as the current one (under Format + Tabs)
SelectDrawingObjects Use to select drawing objects -- drag to create a rectangle enclosing Drawing toolbar
the objects
SendToFax Send this document to fax File menu
SendToOnlineMeetingParticipants Send this document to Netmeeting Online Meeting participant <9>

SentLeft Moves the insertion point to the beginning of the previous sentence

SentLeftExtend Extends the selection to the beginning of the previous sentence

SentRight Moves the insertion point to beginning of the next sentence

SentRightExtend Extends the selection to beginning of the next sentence

SetDrawingDefaults Changes the default drawing object properties to those of the Drawing toolbar

currently selected object

ShadingColor

Changes the shading color of the selected text (except it doesn’t)




Word Command

Description

Version

Shortcut

(which allows you to move text and graphics from nonadjacent
locations)

ShadingPattern Brings up the Format + Borders and Shading dialog
ShowAll Shows/hides all nonprinting characters Standard toolbar Ctrl +*
ShowAllConsistency Crashes Word <9>
ShowAllHeadings Displays all of the heading levels and the body text in Outline View Outlining toolbar Alt + Shift + A
ShowHeading1 Displays the level 1 headings only in Outline View Outlining toolbar
ShowHeading?2 Displays the level 1 and 2 headings in Outline View Outlining toolbar
ShowHeading3 Displays the level 1 through 3 headings in Outline View Outlining toolbar
ShowHeading4 Displays the level 1 through 4 headings in Outline View Outlining toolbar
ShowHeading5 Displays the level 1 through 5 headings in Outline View Outlining toolbar
ShowHeading6 Displays the level 1 through 6 headings in Outline View Outlining toolbar
ShowHeading7 Displays the level 1 through 7 headings in Outline View Outlining toolbar
ShowHeading8 Displays the level 1 through 8 headings in Outline View Outlining toolbar
ShowHeading9 Displays the level 1 through 9 headings in Outline View Outlining toolbar
ShowNextHeaderFooter Shows next section's header/footer in page layout view Header/footer toolbar
ShowPara Shows/hides all nonprinting paragraph marks
ShowPrevHeaderFooter Shows previous section's header/footer in page layout view Header/footer toolbar
ShowPropertyBrowser “Shows the Property Browser” (but actually doesn’t seem to do

anything)
ShowScriptAnchor Show all HTML scripts
ShrinkFont Decreases the font size of the selection Ctrl + <
ShrinkFontOnePoint Decreases the font size of the selection by one point Ctrl + [
ShrinkSelection Shrinks the selection to the next smaller unit (except it does nothing

of the sort)
SkipNumbering Makes the selected paragraphs skip numbering (but does it by

applying manual formatting, so is unstable).
SmallCaps Makes the selection small capitals (toggle) Ctrl + Shift + K
SpaceParal Sets the line spacing to single space Ctrl +1
SpaceParal5 Sets the line spacing to one-and-one-half space Ctrl +5
SpacePara2 Sets the line spacing to double space Ctrl +2
Spike Deletes the selection and adds it to the “Spike” AutoText entry Ctrl + F3




Word Command Description Version Shortcut

SplitSubdocument Splits the selected part of a subdocument into another subdocument Outlining toolbar
at the same level (but avoid using Master Documents)

StartOfColumn Moves to the first cell in the current column Alt + PgUp
StartOfDocExtend Extends the selection to the beginning of the first line of the Ctrl+Shift+Home
document
StartOfDocument Moves the insertion point to the beginning of the first line of the Ctrl +Home
document
StartOfLine Moves the insertion point to the beginning of the current line Home
StartOfLineExtend Extends the selection to the beginning of the current line Shift+Home
StartOfRow Moves to the first cell in the current row Alt+Home
StartOfWindow Moves the insertion point to the beginning of the first visible line on Alt+Ctrl+PgUp
the screen
StartOfWindowExtend Extends the selection to the beginning of the first visible line on the Shift+ Alt+Ctrl+PgUp
screen
Strikethrough Makes the selection strikethrough (toggle)
Style Activates the Style drop-down on the Formatting toolbar Strl + Shift + S
Subscript Makes the selection subscript (toggle) Ctrl + =
Superscript Makes the selection superscript (toggle) Ctrl + +
SymbolFont Applies the Symbol font to the selection Ctrl + Shift + Q
TableAutoFormat Applies a set of formatting to a table Table menu, Tablesand |Alt A, F
Borders toolbar
TableAutoSum Inserts an expression field that automatically sums a table row or
column
TableColumnWidth Displays the Columns tab of Word 97’s Table + Cell Height and
Width dialog
TableDeleteColumn Deletes the selected columns from the table Word 2000 Table menu
TableDeleteGeneral Deletes the selected cells from the table Word 97 Table menu
TableDeleteRow Deletes the selected rows from the table Word 2000 Table menu
TableDeleteTable Deletes the selected table
TableFormatCell Brings up the Table + Cell Height and width dialog (even in Word Word 97 Table menu
2000) ; IN Word 97, intercepts the menu command
TableFormula Inserts a formula field into a table cell Table menu
TableGridlines Toggles table gridlines on and off Table menu

TableHeadings Toggles table headings attribute on and off Table menu Alt A, H




Word Command

Version

Shortcut

Description

TableInsertColumn Inserts one or more columns into the table
TableInsertColumnRight Inserts one or more columns into the table to the right of the current| <9>

column
TableInsertGeneral Context-sensitive. Inserts a table, row, column or cell, depending on Standard toolbar, and

what is selected at the time Word 97 Table menu
TableInsertRow Inserts one or more rows into the table
TableInsertRowAbove Inserts one or more rows above the current one <9> [Word 2000 Table menu
TableInsertRowBelow Inserts one or more rows into the table below the current row <9>
TableMergeCells Merges the selected table cells into a single cell Table menu
TableOptions Displays the Word 2000 Table + Properties + Options dialog. <9>
TableRowHeight Displays the Rows tab of Word 97’s Table + Cell Height and Width

dialog
TableSelectCell Selects the current cell in a table <9> [Word 2000 Table menu
TableSelectColumn Selects the current column in a table Table menu Alt + click (Alt + drag to

select several)

TableSelectRow Selects the current row in a table Table menu Click in left margin
TableSelectTable Selects an entire table Table menu Alt + double-click
TableSort Rearranges the selection into a specified order Table menu
TableSortAToZ Sorts records in ascending order (A to Z) Database toolbar
TableSortZToA Sorts records in descending order (Z to A) Database toolbar
TableSplit Inserts a paragraph mark above the current row in the table Table menu
TableSplitCells Splits the selected table cells Table menu
TableToOrFromText Converts the text to a table or vice versa Word 97 Table menu
TableUpdateAutoFormat Updates the table formatting to match the applied Table Alt+ Ctrl + U

Autoformat settings
TableWrapping Displays the Word 2000 Table + Properties + Positioning dialog
TextBoxLinking Creates a forward link to another text box Text box toolbar & rt-click

menu
TextBoxUnlinking Breaks the forward link to another text box Text box toolbar & rt-click
menu

TextFormField Inserts a text form field Forms toolbar




Word Command

Version

Shortcut

Description

ToggleFieldDisplay Shows the field codes or the results for the selection (toggle) Rt-click menu Shift + F9 (Alt + F9 toggles
all field codes on or off)
ToggleFormsDesign Enables forms using OLE controls to be created. However, OLE Control toolbox toolbar
controls make documents horrendously slow.
ToggleFull Toggles full screen mode on/ off View menu
ToggleHeaderFooterLink Links or unlinks this header/footer to or from the previous section Header/footer toolbar
ToggleMainTextLayer Toggles showing the main text layer when in a Header or footer Header/footer toolbar
ToggleMasterSubdocs Switches between hyperlinks and subdocuments (but avoid Master Outlining toolbar
Documents!). The toolbar button’s tooltip says “Collapse” or
“Expand Subdocuments”.
TogglePortrait Toggles between portrait and landscape mode
ToggleScribbleMode Inserts a pen comment at the location of the insertion point (except
it doesn’t).
ToggleTextFlow Changes text flow direction and character orientation of text within
a table cell - toggles between 3 orientations
ToggleWebDesign Switches on or off web design mode, and displays the Web Tools <9>

toolbar

ToolsAddRecordDefault

Adds a record to a database (or a row to the end of a table)

Database toolbar

ToolsAutoCorrect

Displays the Autocorrect tab of the Tools Autocorrect dialog (does
not intercept the menu command).

Tools menu

ToolsAutoCorrectCapsLockOff

Selects or clears the AutoCorrect Caps Lock Off check box

ToolsAutoCorrectDays

Selects or clears the AutoCorrect Days check box

ToolsAutoCorrectExceptions

Adds or deletes AutoCorrect Capitalization exceptions

ToolsAutoCorrectHECorrect

Hangeul and alphabet correction (whatever that means)

ToolsAutoCorrectlnitialCaps

Selects or clears the AutoCorrect InitialCaps check box

ToolsAutoCorrectReplaceText

Selects or clears the AutoCorrect ReplaceText check box

ToolsAutoCorrectSentenceCaps

Selects or clears the AutoCorrect SentenceCaps check box

ToolsAutoCorrectSmartQuotes

Selects or clears the AutoCorrect SmartQuotes check box

ToolsAutoManager

Displays the Tools + Autocorrect dialog

Tools menu

ToolsAutoSummarize

Automatically generates a summary of the active document

Tools menu

ToolsAutoSummarizeBegin

Automatically generates a summary of the active document




Word Command

Version

Shortcut

ToolsBookshelfDefineReference

Description

Looks up a definition for the selected word in Microsoft Bookshelf

ToolsBookshelfLookupReference

Looks up a reference for the selected word in Microsoft Bookshelf

ToolsBulletListDefault

Creates a bulleted list based on the current defaults (i.e. does the
same thing as FormatBulletDefault)

ToolsBulletsNumbers

Changes the numbered and bulleted paragraphs

ToolsCalculate

Calculates expressions in the selection - very useful

ToolsCompareVersions

Compares the active document with an earlier version (Tools +
Compare Documents)

Tools menu

ToolsConsistency Displays the Spelling and Grammar dialog (but does not intercept <9>
the menu command; ToolsProofing does that). Is also much slower
than using ToolsProofing).

ToolsCreateDirectory Creates a new directory

ToolsCreateEnvelope Displays the Envelopes and Labels dialog

ToolsCreateLabels ToolsCreateLabels

ToolsCustomize Allows you to customizes the Word user interface (menus, Tools menu AltT, C
keyboard and toolbars) and store the customizations in a template
(defaults to Normal.dot, so be careful!)

ToolsCustomizeAddMenuShortcut Allows you to copy an item from a toolbar to the main menu, or to Alt+ Ctrl + =
copy a nested menu item to its main menu. However, it works with (The equals sign on the

some buttons and not others, and it does not give you any control
over where the item gets added (that's all "taken care of" for you by
Microsoft). Using Tools + Customise works much better. But for the
record, an example of the former is: press Alt+Ctrl+=, then click on
the "Insert Microsoft Excel Worksheet" menu on the standard
toolbar. You'll find that the button has now been added to the Insert
menu. An example of the latter: press Alt+Ctrl+= and click on Insert
+ Picture + From File. The button gets inserted (without being
nested) on the main Insert menu. But you can do this far more
straightforwardly and with much more control if you use Tools +
Customize instead.

main keyboard, not the one
on the numeric keypad)




Word Command

Version

Shortcut

ToolsCustomizeRemoveMenuShortcut

Description

Allows you to delete a menu sub-item without having to use the
Customize dialog.Does not wirh toolbar buttons (you can use Alt- +
drag to remove those). Press Alt+Ctrl+Hyphen, and the mouse
cursor changes to a thick black bar. Pull down a menu and click on
the item you want to remove. But be extremely careful - it's easy to
remove the wrong thing by mistake! The main reason it can be
useful is that it's the only way to remove an individual item from
the Most Recently Used Files list without resorting to a macro. But
the macro-based solution for that is much easier - see:
www.mvps.org/word/FAQs/Customization/ OpenMostRecentlyU
sed.htm for details

Alt + Ctrl +-
(The hyphen on the main

keyboard, not the one on the

numeric keypad)

ToolsCustomizeKeyboard

Customizes the Word key assignments

Tools + Customize dialog,
Keyboard button

ToolsCustomizeMenus

Displays the Commands tab of the ToolsCustomize dialog

ToolsEnvelopesAndLabels

Creates or prints an envelope, a label, or a sheet of labels

Tools menu

ToolsFixSynonym Crashes Word. <9>
ToolsGrammar Checks the grammar in the active document
ToolsGrammarHide Hide background grammar errors
ToolsGramSettings Customize Grammar Settings
ToolsHHC Finds a Hangul/Hanja word for the selected word (need to have the| ~ <9>
right language files installed)
ToolsHyphenation Changes the hyphenation settings for the active document Tools menu (under
Language!)
ToolsHyphenationManual Hyphenates the selection or the entire document
ToolsInsertScript Starts or switches to Microsoft Development Environment <9>
application, allowing you to view the HTML/XML source code that
would be behind the document if it were in .htm format (or that is
behind it if it already is in .htm format), and to insert an HTML
script (VBScript, JavaScript, etc)
ToolsLanguage Changes the language formatting of the selected characters Tools menu (Language +
Set Language)
ToolsMacro Runs, creates, deletes, or revises a macro Tools menu (Macro + Alt + F8

Macros)




Word Command

Version

Shortcut

Description

ToolsManageFields Adds or deletes a field from a database (in English that means it Database
adds or removes columns from the current table)
ToolsMergeRevisions Merges changes from the active document to an earlier version

ToolsNumberListDefault

Creates a numbered list based on the current defaults (i.e., does the
same thing as FormatNumberDefault)

ToolsOptions

Changes various categories of Word for Windows options

Tools menu

ToolsOptionsAutoFormat

Displays the AutoFormat tab of the Autocorrect dialog

ToolsOptionsAutoFormatAsYouType

Displays the AutoFormat As You Type tab of the Autocorrect dialog

ToolsOptionsBidi Displays a dialog to change the left-to-right or right-to-left <9>
ReadingOrder settings

ToolsOptionsCompatibility Displays the Compatibility tab of the Tools + Options dialog

ToolsOptionsEdit Displays the Edit tab of the Tools + Options dialog

ToolsOptionsFileLocations Displays the File Locations tab of the Tools + Options dialog

ToolsOptionsFuzzy Displays a Japanese Find options dialog. <9>

ToolsOptionsGeneral Displays the General tab of the Tools + Options dialog

ToolsOptionsGrammar Doesn’t do anything

ToolsOptionsHHC Doesn’t do anything

ToolsOptionsPrint Displays the Print tab of the Tools + Options dialog

ToolsOptionsRevisions Displays the Track Changes tab of the Tools + Options dialog

ToolsOptionsSave Displays the Save tab of the Tools + Options dialog

ToolsOptionsSpelling Displays the Spelling & Grammar tab of the Tools + Options dialog

ToolsOptionsTypography Displays an Asian Typography options dialog <9>

ToolsOptionsUserInfo Displays the User Information tab of the Tools + Options dialog
ToolsOptionsView Displays the View tab of the Tools + Options dialog
ToolsProofing Checks the spelling and grammar in the active document Tools menu F7

ToolsProtectUnprotectDocument

Sets protection for the active document

Tools menu

ToolsRecordMacroStart

Turns macro recording on or off

ToolsRecordMacroStop

Turns macro recording on or off




Word Command
ToolsRecordMacroToggle

Description

Turns macro recording on or off

Version

Visual Basic toolbar

Shortcut

ToolsRemoveRecordDefault

Removes a record from a database (or in English, deletes the current
row from a table)

Database toolbar

ToolsRepaginate

Recalculates the page breaks (quite useful if you use Normal view a
lot)

ToolsReviewRevisions

Displays the Accept or Reject changes dialog

Tools menu

ToolsRevisionMarksAccept

Accepts change in current selection.

ToolsRevisionMarksNext

Find next change

ToolsRevisionMarksPrev

Find previous change

ToolsRevisionMarksReject

Rejects change in current selection.

ToolsRevisionMarksToggle Toggles track changes for the active document Ctr.l + Shift + E
ToolsRevisions Sets track changes for the active document
ToolsSCTCTranslate Translates chinese string (need to have the appropriate language <9>
settings installed)
ToolsShrinkToFit Attempts to make the document fit on one less page Print Preview toolbar
ToolsSpelling Checks the spelling in the active document (but does not intercept
the menu command)
ToolsSpellingHide Hide background spelling errors in the current document
ToolsSpellingRecheckDocument Resets spelling results for current document
ToolsSpellSelection Checks the spelling of the selected text
ToolsTCSCTranslate Translates chinese string (need to have the appropriate language <9>
settings installed)
ToolsTCSCTranslation Translates chinese string (need to have the appropriate language <9>
settings installed)
ToolsThesaurus Finds a synonym for the selected word Tools menu (under Shift + F7

Language)

ToolsTranslateChinese

Translates chinese string (need to have the appropriate language
settings installed)

ToolsWordCount

Displays the word count statistics of the active document

Tools menu




Word Command

Version

Shortcut

Description

TopAlign Aligns cell content to the top of cell - very useful and unfortunately, Word 97 right-click menus
not accessible via the default Word 2000. menus. It is well worth and Word 97 Tables and
replacing the Word 2000 Cell Alignment buttons on the right-click Borders menu
table menus and on the Tables and Borders toolbar, with
BottomAlign, CenterAlign and TopAlign buttons. The Word 2000
buttons, unfortunately, apply manual left center or justified
paragraph formatting to the text in the cells, which is the last thing
you would ever want to happen!
TopCenterAlign Aligns cell content to the top-center of cell (yuckk!!) <9> |Word 2000 right-click
menus and Word 2000
Tables and Borders menu
TopLeftAlign Aligns cell content to the top-left of cell (yuckk!!) <9> |Word 2000 right-click
menus and Word 2000
Tables and Borders menu
TopRightAlign Aligns cell content to the top-right of cell (yuckk!!) <9> |Word 2000 right-click
menus and Word 2000
Tables and Borders menu
Underline Formats the selection with a continuous underline (toggle) Formatting toolbar Ctrl+U
UnderlineColor Changes the underline color of the selected text (except it doesn't) <9>
UnderlineStyle Does exactly the same thing as Underline <9>
UnHang Decreases the hanging indent Ctrl + Shift + T (or drag the
ruler)
UnIndent Moves the left indent to the previous tab stop Ctrl + Shift + M (or drag the
ruler)
UnIndentChar Decreases the indent by width of a character <9>
UnIndentFirstChar Decreases the hanging indent by width of a character <9>
UnIndentFirstLine Decreases the hanging indent by width of 2 characters <9>
UnIndentLine Decreases the indent by width of 2 characters <9>
UnlinkFields Permanently replaces the field codes with the results Ctrl+Shift+F9




Word Command

Description

Shortcut

UnlockFields Unlocks the selected fields for updating Ctrl + Shift + F11
UpdateFields Updates and displays the results of the selected fields F9
UpdateSource Copies the modified text of a linked file back to its source file Ctrl + Shiift + F7
UpdateToc Select method of updating a table of contents or figures (equivalent
to selecting the TOC and pressing F9)
UpdateTocFull Rebuild a table of contents or figures (equivalent to selecting the
TOC, pressing F9, and then selecting "Update entire table" when
asked).
ViewAnnotations Show or hide the comment pane View menu (View + Hover over comment
Comments)
ViewBorderToolbar Shows or hides the Tables and Borders toolbar Standard toolbar (but you
can right-click on any
toolbar to select which
toolbars should be visible)
ViewCode View Code for Selected Control Control toolbox toolbar
and right-click menu
ViewControlToolbox Shows or hides the Control Toolbox
ViewDocumentMap Toggles state of the Document Map (warning - the Document Map View menu and Standard
has a way of destroying documents; Outline View is much safer). toolbar
ViewDraft Displays the document without formatting and pictures for faster
editing (toggle)
ViewDrawingToolbar Shows or hides the Drawing toolbar Standard toolbar (but you
can right-click on any
toolbar to select which
toolbars should be visible)
ViewEndnoteArea If in Normal View, opens a pane for viewing and editing the Dbl-click the endnote
endnote (toggle). If in Page/Print Layout View, switches from the reference
body text to the endnote or vice versa
ViewEndnoteContNotice Opens a pane for viewing and editing the endnote continuation Endnote pane (in Normal
notice View)




Word Command

Description

Version

Shortcut

ViewEndnoteContSeparator

Opens a pane for viewing and editing the endnote continuation
separator

Endnote pane (in Normal
View)

ViewEndnoteSeparator

Opens a pane for viewing and editing the endnote separator

Endnote pane (in Normal
View)

ViewFieldCodes Shows the field codes or results for all fields (toggle) At+F9
ViewFooter Displays footer in page layout view
ViewFootnoteArea If in Normal View, opens a pane for viewing and editing the Dbl-click the footnote

footnote (toggle). If in Page/Print Layout View, switches from the
body text to the footnote or vice versa.

reference

ViewFootnoteContNotice

Opens a pane for viewing and editing the footnote continuation
notice

Footnote pane (in Normal
View)

ViewFootnoteContSeparator

Opens a pane for viewing and editing the footnote continuation
separator

Footnote pane (in Normal
View)

ViewFootnotes If in Normal View, opens a pane for viewing and editing footnotes View menu AltV,F
and endnotes (toggle). If in Page/Print Layout View, switches from
the body text to the footnotes/endnotes or vice versa.
ViewFootnoteSeparator Opens a pane for viewing and editing the footnote separator Footnote pane (in Normal
View)
ViewFormatExToolbar Shows or hides the Word 2000 Extended Formatting toolbar (the <9>
one toolbar you can’t show/hide by right-clicking on a toolbar)
ViewGridlines Doesn’t do anything <9>
ViewHeader Displays header in page layout view View menu AltV,H
ViewHTMLSource Starts or switches to Microsoft Development Environment <9>
application, allowing you to view the HTML/ XML source code that
would be behind the document if it were in .htm format (or that is
behind it if it already is in .htm format).
ViewMasterDocument Switches to Master Document view (but avoid using Master
Documents)
ViewNormal Changes the editing view to normal view View menu Alt V, N (or Alt + Ctrl + N)




Word Command

Version

Shortcut

Description

ViewOnline Displays the document as it would appear in IE5 if saved as an htm Word 97 View menu
file. Intercepts the Word 97 menu command but not the Word 2000
one (brilliantly thought out compatibility strategy!)
ViewOutline Displays a document's outline View menu AltV, O (or Alt + Ctrl + O)
ViewOutlineMaster Exactly the same as ViewMasterDocument <9>
ViewOutlineSplitToolbar Shows or hides the Tables and Borders toolbar (but does not
intercept the button on the standard toolbar; ViewBorderToolbar
does that).
ViewPage Displays the page more-or-less as it will be printed, and allows View menu AltV, P (or Alt + Ctrl + P)
editing (In Word 2000 the menu item is called Print Layout, but
fortunately the command hasn’t changed.
ViewRuler Shows or hides the ruler
ViewSecurity Displays the Security settings dialog <9> |Word 2000 Tools menu
(under Macro)
ViewStatusBar Shows or hides the status bar
ViewToggleMasterDocument Switches between Outline and Master Document views (but avoid Outlining toolbar
using Master Documents)
ViewToolbars Doesn’t actually do anything
ViewVBCode Shows the VB editing environment (Tools + Macro + Visual Basic Tools menu Alt + F11
Editor)
ViewWeb Displays the document as it would appear in IE5 if saved as an htm <9> |Word 2000 View menu
file. Intercepts the Word 97 menu command but not the Word 2000
one (brilliantly thought out compatibility strategy!)
ViewWebToolbox Shows or hides the Web Toolbox toolbar (but you can do that
simply by right-clicking on any toolbar)
ViewZoom Displays a dialog to scale the editing view View menu
ViewZoom100 Scales the editing view to 100% in normal view
ViewZoom200 Scales the editing view to 200% in normal view
ViewZoom?75 Scales the editing view to 75% in normal view
ViewZoomPageWidth Scales the editing view to see the width of the page

ViewZoomWholePage

Scales the editing view to see the whole page in page layout view




Word Command

Description

Version

Shortcut

WebAddHyperlnkToFavorites Add to Favourites
WebAddress Hyperlink Address
WebAddToFavorites Add to Favourites Web toolbar
WebBanishWebToolbarForever No such command, unfortunately, but see: How to stop the web
toolbar from jumping up at you whenever you click on a page
number in the table of contents
WebCopyHyperlink Copy Hyperlink
WebGoBack Backward hyperlink (useful if you clicked on a page number Web toolbar Alt + left arrow
hyperlink in the table of contents and then want to return to the
TOC)
WebGoForward Forward hyperlink Web toolbar Alt + rt arrow
WebHideToolbars Hide other toolbars Web toolbar
WebOpenFavorites Open Favourites folder
WebOpenHyperlink Jump to a location...
WebOpenInNewWindow Open in New Window Web toolbar
WebOpenSearchPage Open Search Page
WebOpenStartPage Open Start Page
WebOptions Displays the Word 2000+ Tools + Options + General + Web Options| <9>
dialog
WebPagePreview Displays full pages in a Web browser (and makes you realise just <9>
how slowly web pages created in Word actually load)
WebRefresh Refresh current page
WebSelectHyperlink Edit Text
WebStopLoading Stop current jump Web toolbar
WebToolbar Toggle Web toolbar
WindowArrangeAll Arranges windows as non-overlapping tiles Window menu AltW, A
WindowList Switches to the window containing the specified document
WindowNewWindow Opens another window for the active document Window menu
WordLeft Moves the insertion point to the left one word Ctrl + left arrow
WordLeftExtend Extends the selection to the left one word Shift + Ctrl + left arrow
WordRight Moves the insertion point to the right one word Ctrl + rt arrow

WordRightExtend

Extends the selection to the right one word

Shift + Ctrl + rt arrow




Word Command Description Version Shortcut

WordUnderline Underlines the words but not the spaces in the selection (toggle) Ctrl + Shift + W
WW?7_Decreaselndent Does exactly the same as DecreaseIndent

WW?7_DrawTextBox Does exactly the same as DrawTextBox

WW?7_Draw Vertical TextBox Does exactly the same as DrawVerticalTextBox

WW?7_FormatDrawingObject Does exactly the same as FormatDrawingObject

WW?7_Increaselndent Does exactly the same as IncreaseIndent

WW?7_ToolsOptions Does exactly the same as ToolsOptions




